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Using This Document 
 

Before You Begin 
This document details how to upgrade an existing MassTransit 5.1 or 6.0 installation to MassTransit 6.1. 
Please follow the steps carefully to ensure that all of your settings are maintained with the new 
installation. 
 
Before starting the upgrade process, please verify that you have the following: 

¥ Version number of MassTransit you are currently running. 
¥ Version number of MySQL you are currently running. To verify the version number: 

o Go to Start->Run and enter cmd to open the command line. 
o Enter mysql ÐV at the prompt. 

¥ MassTransit installers downloaded electronically see http://support.grouplogic.com/mtlatest). 
¥ MassTransit serial number for version 6.x. To locate your current serial number, launch the 

MassTransit Administrator, go to the File menu, and select Server Information. Your serial 
number is the last item listed in the Licensed To: section. Users upgrading from a version prior to 
6.0 must obtain a version 6.x serial number from Group Logic; see contact information below. 

 
Please contact Group Logic Technical Support if you need to obtain any of the items above. Email 
support@grouplogic.com or call 703-527-7979. 
 
You should be logged in as an administrator to install MySQL and MassTransit 6.1. 
 

MassTransit Versions Prior to 5.1 
If your current installation of MassTransit is a version less than version 5.1, you will need to upgrade to 
MassTransit 5.1 prior to upgrading to MassTransit 6.1. To download MassTransit 5.1, go to the 
MassTransit 5 Releases section located at: http://support.grouplogic.com/mtlatest. This Web site also 
includes upgrading instructions in the MassTransit 5 Documentation section. Once you have successfully 
upgraded to MassTransit 5.1, you can then upgrade to MassTransit 6 by following the instructions below. 

 

Upgrading Process 
This document includes details on how to upgrade to MassTransit 6.1. You should not launch 
MassTransit until you have completed all of the processes outlined in this document. 
 
The upgrading process is a series of major steps: 

1. Backing up your existing installation of MassTransit. 
2. Backing up your MassTransit databases from MySQL. 
3. Upgrading to MassTransit 6.1. 
4. Migrating custom configurations to the new MassTransit installation. 
5. Verifying the success of the new installation. 

 
It is highly recommended that you back up your original MassTransit application folder and databases so 
that if you encounter problems, you can still run from the backup until support can resolve the issue. 
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Step 1: Application and Database Backups 
Before upgrading your existing MassTransit installation to a new version it is advisable to make a backup. 
If you do not back up your MassTransit installation, including the database back up, you will not be able to 
revert back to your old MassTransit version. 
 
You will need to select a backup location for MassTransit, e.g. a different folder on the same volume, a 
network volume, a CD, etc. It is highly recommended that you make backups immediately before you 
upgrade and do not run the older version of MassTransit again to ensure that the transition between the 
two servers is seamless. If you encounter a problem running with the new version of MassTransit, you 
can revert to this saved application folder until the issue can be resolved. 
 

MassTransit Application Backup 
Perform the following steps to make a backup copy of the MassTransit application folder: 
 

1. If MassTransit is currently running, complete all file transfers and stop the MassTransit 
Service. 

2. Locate the folder that contains the old MassTransit application. 
3. Copy the entire MassTransit application folder to your backup location. 

 

MySQL Database Backup 
Perform the following steps to make a backup copy of the MassTransit database.  
 

1. Stop the MassTransit Service from the Services console (available in Start->All Programs-
>Administrative Tools). 

2. Make a backup copy of the MySQL installation folder. If space requirements are an issue, 
you may copy the data folder only. The folder can be found at one of the following default 
installation path (depending on the version of MySQL you are running):  
  

  C: \ Progra m Files \ MySQL\ MySQL Server 4.1 \ data  
C: \ Program Files \ MySQL\ MySQL Server 5.0 \ data  

 
NOTE: On 64-bit machines, the default installation path is one of the following: 

C: \ Program Files  (x86) \ MySQL\ MySQL Server 4.1 \ data  
C: \ Program Files  (x86) \ MySQL\ MySQL Server 5.0 \ data  

 
NOTE: This step is imperative. This backup folder can be used later to restore your database 
information and fix the GRANTS table if problems occur during the updating process. 

 
3. Make backups of the MTDATABASE and MYSQL schemas using MySQL Administrator. 

When backing up, ensure that the Lock All Tables execution method is selected under the 
Advanced Options tab.  



  MassTransit Upgrade Guide – Windows 

 Page 6 

 

Step 2: Upgrading MySQL 
MassTransit 6.1 requires the use of MySQL version 5.0.78, which allows for faster performance, better 
management, enhanced data integrity, improved security and additional replication services. If your 
current installation of MySQL is version 5.0.42, you need to upgrade to MySQL 5.0.78 prior to installing 
MassTransit 6.1. If your current installation of MySQL is version 4, see Appendix A: Upgrading from 
MySQL 4 to MySQL 5. If MySQL 5.0.78 is already installed, please skip to the Windows Upgrade to 
MassTransit 6.1 section of this document. 
 

What you will need… 
To complete the MySQL 5 upgrade, you will need:  

1. A mysql-classic-5.0.78-win32.zip file. This file is available on the MassTransit releases web page: 
http://support.grouplogic.com/?page_id=70. 

2. Administrative login permissions for the machine you want to upgrade.  
 

MySQL Database Backup 
First you must back up existing MySQL version 5 data. You should have already done this in the previous 
section: MySQL Database Backup. 
 

Install MySQL 5.0.78 
1. Stop the MassTransit Service from the Services console inside Administrative Tools. 
2. Stop the MySQL Service from the Services console inside Administrative Tools. If stopping the 

service fails for some reason, you may also use the following command on 32-bit machines 
(where PASSWORD is the root password for your MySQL 5 server): 

"C: \ Pr ogram Files \ MySQL\ MySQL Server 5 . 0\ bin \ mysqladminÓ - uroot ÐpPASSWORD shutdown  
On 64-bit machines, use the following command: 

"C: \ Pr ogram Files  (x86) \ MySQL\ MySQL Server 5 . 0\ bin \ mysqladminÓ - uroot ÐpPASSWORD 
shutdown  

 
NOTE: This is imperative, as the upgrade can be compromised if the service has not properly 
shut down. 
 

3. Unzip the MySQL installation files, mysql-classic-5.0.78-win32.zip, located on your download 
package. A directory opens containing the required installer, Setup.exe.  

4. To install the MySQL engine, double click Setup.exe. 
5. An introduction window appears. Select the Next button to proceed. 
6. The “License Agreement” window appears. The Next button is enabled after you select I accept 

the terms in the license agreement. Read the license and select Next to continue or select 
Cancel to cancel the installation. 

7. The “Setup Type” window appears. Select the Typical setup type and then select the Next 
button. 

8. The “Ready to Install the Program” window appears next. Once you have verified that all of the 
settings are accurate, select the Install button. 

9. While the installation completes, the “Installing MySQL Server 5.0” window appears.  
10. Two “MySQL Enterprise Subscription” windows appear next. On both windows you may select 

More for more information or Next to continue. 
11. The “Wizard Completed” window appears next. Check the Configure the MySQL Server now 

check box to configure your server. Select the Finish button to proceed. 
12. The “MySQL Server Instance Configuration Wizard” then launches; select Next to continue. 
13. Select the Reconfigure Instance option in the next window and click Next to continue. 
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14. The next window asks you to select a configuration type. Select the Standard Configuration and 
then select Next to continue. 

15. The next window asks you to set the Windows options: 
a. Check the checkbox for Include Bin Directory in Windows PATH. 
b. Select Next. 

16. The next window asks you to set the Security options:  
a. Select the Modify Security Settings checkbox to set a password for your root account. 

i. Enter your current root password used on MySQL 5.0.42. 
ii. Enter a root password for MySQL 5.0.78. It’s recommended to use the same 

password as you used for MySQL 5.0.42. 
iii. Retype the password for verification. 
iv. Select the Enable root access from remote machines checkbox if you would 

like to give remote machines root access to MySQL. This is not recommended. 
b. Uncheck the Create An Anonymous Account checkbox. 
c. Select Next to continue. 

17. The “Ready to execute…” window appears next. Select the Execute button to start the 
configuration. 

18. Once the configuration is complete select the Finish button. 
19. Go to the folder where you installed MySQL (the default location for 32-bit machines is 

C:\Program Files\MySQL\MySQL Server 5.0 and C:\Program Files (x86)\MySQL\MySQL Server 
5.0 for 64-bit machines). Open the my.ini file in a text editor. 

20. Add the following line to the end of the file: 
temp - pool=0  

21. Save and close my.ini. 
22. In the services control panel, restart the MySQL service. 

 
The MySQL Installer will automatically install the service and attempt to start the MySQL Engine once 
complete. In the event the service does not start, check the MACHINENAME.ERR file in the C:\Program 
Files\MySQL\MySQL Server 5.0\data (C:\Program Files (x86)\MySQL\MySQL Server 5.0\data for 64-bit 
machines) directory for hints as to the exact reason. See the Troubleshooting section of this document for 
more detail if you encounter problems. 
 

Security Configurations for MySQL  
It is critical that the directory where the MySQL database files are stored (C:\Program Files\MySQL 
Server 5.0\data by default on 32-bit machines and C:\Program Files (x86)\MySQL\MySQL Server 
5.0\data by default on 64-bit machines) and the Windows temp directory (c:\tmp) be excluded from virus 
scan and server backups. Both virus scan tools and backup tools can lock key files in these folders and 
interrupt operation of the MySQL server, and by extension, MassTransit.  
 
To backup the MySQL databases, it is recommended that you use the MySQL or other standard tools to 
automatically save the backup files to a directory or volume that can then be processed by your backup or 
archiving solution.  
 
By default, MySQL uses TCP/IP port 3306 to accept client communications. It is recommended to restrict 
traffic on this port by setting appropriate firewall rules. Normally, the only remote computers that should 
be allowed to access MySQL on the MassTransit server are those running the MassTransit Administrator 
(or those running the MassTransit Engine or MTWeb in the rare configurations where MySQL is not 
running on the same server as MassTransit). 
 
You should configure MySQL with a strong root password of 8 or more characters with a variety of letters, 
numbers, and symbols. To change your MySQL root password:  

1. Open a command prompt. 
2. Enter the following command, where PASSWORD is your current root password:  

ÒC:\ Program Files \ MySQL\ MySQL Server 5.0 \ bin \ mysql.exeÓ Ðuroot ÐpPASSWORD 
 
NOTE: On 64-bit machine, enter the following command: 
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ÒC:\ Program Files  (x86) \ MySQL\ MySQL Server 5.0 \ bin \ mysql.exeÓ Ðuroot ÐpPASSWORD 
 

3. Enter the following at the MySQL prompt:  
UPDATE mysql.user SET Password=PASSWORD(Ô MyNewPassÕ) WHERE User=ÕrootÕ;  
FLUSH PRIVILEGES;  
Quit;  

 Enter your desired root password in place of MyNewPass in the first command. 
Your MySQL root password has now been changed. You may close the command prompt. 
 

MassTransit Running on a Remote Server 
If MassTransit is running on a remote server, separate from where MySQL is installed, you will need to 
execute the following command on the MySQL command prompt before installing MassTransit: 
 

GRANT ALL PRIVILEGES ON *.* TO 'root'@'<REMOTE IP ADDRESS>' identified by 
'<PASSWORD>' WITH GRANT OPTION 

 
In the above statement, replace <REMOTE IP ADDRESS> with the MassTransit Server IP Address and 
replace '<PASSWORD>' with the root MySQL password. 
 

MySQL Upgrade Complete 
The MySQL 5.0.78 upgrade is now complete. Restoring the MySQL 5.0.42 Database is not necessary 
since the upgrade does not change it. If problems occur during the upgrading process, you can restore 
the database information by replacing the MySQL data folder (it’s located in C:\Program 
Files\MySQL\MySQL Server 5.0\ by default) with the backed up one. You may now restart the 
MassTransit Engine. Your MassTransit installation is now running against MySQL 5.0.78. You can now 
upgrade to MassTransit 6.1. 
 
NOTE: On 64-bit machines, the default location of the MySQL database files is C:\Program Files 
(x86)\MySQL\MySQL Server 5.0. 
 
If you allow remote administration of MassTransit and do not click the checkbox for Remote 
Administration as part of the MassTransit 6.1 installation (Step 11), then you will need to follow the 
instruction on how to configure remote administration for MassTransit and MySQL. 
 

Troubleshooting 
 
Problem: MySQL Error 1067 occurs when attempting to start the service. 
Solution: If you encounter a MySQL Error 1067 when attempting to start the service, check the data 
directory in your MySQL 5.0 folder. The file machinename.err (where machinename is your server name) 
will reveal the most common problems. This link explains the issue and a possible resolution: 
http://forums.mysql.com/read.php?11,11388,11456 - msg-11456. 
 
Problem: MySQL will not start, and the machine was not restarted after uninstalling MySQL 5.0.42. 
Solution: Installing MySQL 5.0.78 immediately after uninstalling MySQL 5.0.42 without restarting 
Windows can cause the Server Instance Configuration to fail. To resolve this issue, use the following 
steps:  

1. Uninstall MySQL 5.0.78 Server using Add/Remove Programs in Control Panel.  
2. Delete the MySQL 5 Server folder. This is usually located at C:\Program Files\MySQL 

(C:\Program Files (x86)\MySQL for 64-bit machines). Verify that there are still existing backups 
for the original MySQL 4 database.  

3. Open Registry Editor by clicking Start, then Run…, then typing regedit in the Run window.  
4. Navigate to HKEY_LOCAL_MACHINE/SOFTWARE/MySQL AB and delete the MySQL Server 

5.0 folder.  
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Restart Windows. Reinstall MySQL Server 5 and proceed with the installation steps from earlier in this 
document. The Server Instance Configuration should now execute successfully.
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Step 3: Windows Upgrade to MassTransit 6.1 
 

MassTransit Upgrade to 6.1 
To install MassTransit 6.1 on Windows Server 2003 or 2008 you will need to have a version 6.x serial 
number. Please contact Group Logic Technical Support if you need to obtain one. Email 
support@grouplogic.com or call 703-527-7979. Group Logic is no longer supporting Windows 2000 
Server or Professional. MassTransit 6.1 installs to a different installation folder. You should not install to 
the same directory as a previous MassTransit 5 installation. 
 

Premier and Standard Servers 
 

1. Be sure that you have sent all queued files. 
2. If MassTransit is currently running, stop the service. 
3. Back up your MassTransit application folder; see the Application and Database Backups section. 
4. Verify MySQL 5 is installed and running as a service.  
5. Double click InstallMT6Server.exe to launch the InstallShield Wizard. 

 
NOTE: you may quit the installation at any time; the Cancel button is enabled until the Install 
button is selected. 
 

6. A “Preparing to Install…” window remains open until the installation preparation is complete. 
7. When the installation preparation completes, the “Welcome to the InstallShield Wizard for 

MassTransit Server 6” window appears. Select the Next button to continue.  
8. The “License Agreement” window appears next. The Next button is enabled after you select I 

accept the terms in the license agreement. Once you have read and agreed with the license 
agreement, select Next to continue or select Cancel to cancel the installation. 

9. The “ReadMe Information” window appears next; after reading it select Next to continue. 
10. The “MassTransit Server 6 Features” window appears next. Select the features that you would 

like to install. All items are checked by default. 
a. Checking the MassTransit Server Engine will install both the Engine and the MassTransit 

Administrator; this is necessary so you can configure the Engine. 
b. Checking just the MassTransit Administrator will install just the Administrator.  
c. Checking the MassTransit Manuals will install manuals and documentation. 
d. Once you have made your selection, select Next to continue. 

11. The “MySQL Settings” window appears next. 
a. In the MySQL MassTransit Account section, the following information is required: 

i. Hostname: [default: localhost] Leave this setting configured as “localhost” so 
MassTransit can access the local database. Do not use your local IP address. If 
MassTransit is on a remote server, enter the IP address of the machine where 
MySQL is installed. 

ii. Port: [default: 3306] Leave this setting configured to “3306” unless you have 
changed the TCP port used by the MySQL database server (this is rare). 

iii. Username: [default: masstransit] This will be the name of the user account 
created in MySQL that MassTransit will use to access the database. In order to 
ensure that all your remote access permissions from MassTransit 5.1 or 6.0 are 
maintained, it is highly recommended to use the same username used by your 
existing MassTransit installation. You can find this username in the 
MassTransitEngine.cfg file in your MassTransit backup folder under 
DATABASE_USER. Do not use root. 

iv. Password: This will be the password for the user account created in MySQL that 
MassTransit will use to access the database. You may change it to any password 
you wish. It is highly recommended to use the same password used by your 
existing MassTransit installation. 
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v. Confirm Password: Please retype your password for verification. 
vi.  “Enable remote login for this account”: [default: not selected] If you wish to allow 

administration of the MassTransit server using the MassTransit Administrator 
from other machines, you will need to check this option. If it is not checked, your 
MassTransit server will not allow remote administration, although you will be able 
to administer the server locally. If you wish to allow remote administration, it 
is recommended that you enable it at this time; if you do not enable it now, 
you will later have to manually configure the proper permissions for both 
MassTransit and MySQL. Instructions on how to manually configure this can be 
found below in the Configuring Remote Administration section of this document. 

b. Enter your MySQL root password. The root password is required so that the MassTransit 
installer can create the new user account in MySQL. 

c. Select Next to continue. 
12. Once the installer validates the entered information, a dialog appears stating, “MySQL account 

configured successfully!” Select OK to continue.  
13. The “Destination Folder” window appears. The default installation location for 32-bit machines is 

C:\Program Files\Group Logic\MassTransit Server 6\ and C:\Program Files (x86)\Group 
Logic\MassTransit Server 6\ for 64-bit machines. 

a. Select the Change button to install to a different location. 
b. Select Next to continue. 

14. The “Customer Information” window appears next; all fields are mandatory. 
a. Enter your User Name. 
b. Enter the name of your Organization. 
c. Enter the Serial Number provided to you by Group Logic for MassTransit 6.1. 
d. Enter the Server Name; it auto-populates so verify that it is correct. 
e. Select whom the application should be installed for: anyone using this computer or only 

you. The default is Anyone who uses this computer (all users). 
f. Select Next to continue. 

15. The “Ready to Install the Program” window appears next. If you would like to make any changes 
to your installation, do so now. Once you have verified that all of the settings are accurate, select 
the Install button. 

16. A dialog will appear asking, “Would you like to install Dongle Drivers?” Select Yes. 
17. A dialog appears stating that the dongle must be removed prior to the installation.  If you have a 

MassTransit hardware dongle plugged in, remove it now.  Once the dongle has been unplugged 
select OK to continue.  You will be prompted later to plug the dongle back in. 

18. A dialog appears stating that the Sentinel Protection installer is being configured.  This installs the 
drivers for the dongle. 

19. Once the Sentinel Protection Installer is complete, a dialog will prompt you to plug the dongle in. 
If you have one, plug it in and select OK to continue. Otherwise, just click OK. 

20. When the installation is complete, the “InstallShield Wizard Completed” window appears. Select 
Finish. 

21. If you have a mtdongle.cfg file that you received from Group Logic, copy it into the MassTransit 
installation directory. This file contains your license information. 

 
The MassTransit upgrade is not yet complete. Do not launch MassTransit until you have completed all 
of the steps in the upgrading instructions in the Migrating Configurations section. 
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Step 4: Migrating Configurations  
The following sections detail how to ensure that all configurations are properly migrated from the old 
MassTransit installation to the new one. If you installed MassTransit to the default location, the new 
installation folder will be: C:\Program Files\Group Logic\MassTransit Server 6 (C:\Program Files 
(x86)\Group Logic\MassTransit Server 6 for 64-bit machines). 
 

Copying User Mailboxes  
Copy your User Mailboxes folder from the backup of the old MassTransit Folder to the new MassTransit 
Folder. If you choose not to do this, MassTransit will create a new User Mailboxes folder when it starts 
up. 
 

Preserving MassTransit.cfg and MassTransitEngine.cfg Settings  
For Premier and Standard Servers only 
If you were using the MassTransit.cfg and MassTransitEngine.cfg files to specify settings for the previous 
MassTransit installation, you will need to make equivalent changes in the updated version of the 
MassTransit.cfg and MassTransitEngine.cfg files. 
 
DO NOT simply drop the old MassTransit.cfg and MassTransitEngine.cfg files in the new MassTransit 
directory. Some changes may have been made to the settings in these files and using the newest version 
ensures proper operation. 
 

1. Open the new MassTransitEngine.cfg file in the root MassTransit folder in a text editor. 
2. Open the MassTransitEngine.cfg file that you backed up from your old installation in a text editor. 

You may want to rename this file oldMassTransitEngine.cfg to avoid confusion over which is the 
new file. 

3. For each enabled setting in your old MassTransitEngine.cfg file, uncomment the same setting 
and set the value appropriately in the new MassTransitEngine.cfg file. Settings with a ‘%’ 
preceding them are not enabled. Do not change the settings for DATABASE_HOST, 
DATABASE_NAME, DATABASE_USER, or DATABASE_PASSWORD. 

4. Save the new MassTransitEngine.cfg file. 
5. Copy the new version of the MassTransit.cfg file from the “Extras” folder of the new MassTransit 

6 installation to the main MassTransit folder. 
6. Open the new MassTransit.cfg file in a text editor. 
7. Open the MassTransit.cfg file that you backed up from your old installation in a text editor. You 

may want to rename this file oldMassTransit.cfg to avoid confusion over which is the new file. 
8. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and set 

the value appropriately in the new MassTransit.cfg file. Settings with a ‘%’ preceding them are not 
enabled. 

9. Save the new MassTransit.cfg file. 
 
 

Maintaining MT IP Addresses.txt 
If you were using MT IP Addresses.txt on the previous MassTransit installation, copy the MT IP 
Addresses.txt file that you backed up into the new MassTransit folder. No changes to the actual file are 
required. If in use, the MT IP Addresses.txt file is found in the root MassTransit folder. 
 



  MassTransit Upgrade Guide – Windows 

 Page 13 

Preserving Administrator Connection Configuration 
In order to preserve the list of servers the MassTransit Administrator can connect to, copy all files in the 
ServerPreferences folder in the backed up MassTransit installation to the ServerPreferences folder in the 
new MassTransit installation. 
 

Consider Updating Aliases and Shortcuts 
If you have an alias or shortcut that you used to launch the previous version of the MassTransit, you may 
want to update it to point to the new version. This is especially important if you have one as a startup 
item, to ensure that the old version of MassTransit is not launched automatically. 
 

Web Configuration for Standard and Premier Servers 
MassTransit 6.1 will require updates to the Web Configuration. For information about configuring 
MassTransit for use with web servers, see the Web Configuration Instructions document located on the 
MassTransit Latest Releases web page in the MassTransit 6 Documentation section:  
http://www.grouplogic.com/files/glidownload/mtreleases.cfm. 
 
 

Maintaining Verified Certificates 
If you are using a verified certificate [e.g. one purchased from VeriSign], you may need to ensure that the 
certificate and private key files are configured properly for the new version of MassTransit. 
 
If the certificate and/or private key files were not located within the previous MassTransit installation 
folder, then no action is needed as MassTransit will continue to find the files in their present location if you 
are installing on the same server. 
 
If the certificate and/or private key files were located in the “Security” folder of the previous MassTransit 
installation, they will need to be moved to the “Security” folder of the new MassTransit installation. In 
addition, restart the MassTransit service, go to Setup->Security and update the preferences to access 
the files at their new location. If you are using verified SSL certificates, the mtcert.pem (located in the 
Security folder) and mtkey.pem (located in the Security\private folder) files must be manually moved from 
the backed up Security folder into the MassTransit 6 Security folder. Do not simply copy the old Security 
folder to the new MassTransit 6 installation as other files in the folder have been updated for version 6. 
 
If you are not installing MassTransit 6.1 on the same server, then you will need to copy the certificate 
and/or private key files to the new server and update the preferences in MassTransit on the Setup-
>Security tab to access the files at the new location. 
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Step 5: Verifying the Upgrade 
Once you have completed all the upgrade steps, you can launch the MassTransit service. 
 

Launching the MassTransit Engine 
 

1. The MassTransit Engine must be started via the Services Control Panel. To access the Services 
Control Panel, go to Start -> Programs -> Administrative Tools -> Services. 

2. Once the Services window is open, highlight the service named “MassTransit” and select the 
Start Service button. 

3. The default startup type for the MassTransit service is Automatic, thus anytime your machine 
reboots, the MassTransit service automatically starts. 
 
NOTE: MassTransit is dependent upon MySQL and will fail if MySQL is not started. Make sure 
the MySQL service is set to start automatically. If you find that MassTransit is attempting to start 
before MySQL is ready, you can modify the options in the Recovery tab of the MassTransit 
service to have it retry.  
 

4. If you would like the MassTransit Engine service to access network volumes, do the following: 
a. Go to the Services window via Start -> Programs -> Administrative Tools -> 

Services. Highlight the MassTransit service, right click, and select Properties to open the 
"Properties" window. 

b. Go to the Log On tab and select the This account: option. 
i. Select the Browse button to browse for your valid domain user that has access 

to the volumes needed. 
ii. Enter and confirm your password. 
iii. Select OK to finish and close the "Properties" window. 

 

Launching the MassTransit Administrator 
 

1. Double click the MassTransit Administrator.exe located in the root MassTransit folder to connect 
to your MassTransit server; the default location is C:\Program Files\Group Logic\MassTransit 
Server 6 (C:\Program Files (x86)\Group Logic\MassTransit Server 6 for 64-bit machines). 

2. The “MassTransit Servers” window appears. 
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3. If you did not preserve your server preferences, add the server you wish to connect to:  

a. Select the Edit Server List… button; the “MassTransit Server List” appears.  

 
b. Select the Add button; the “Configure MassTransit Server Connection” dialog appears.  

 
c. Add the name and address of the server you are connecting to; all fields are required. If 

Remote Administration is enabled and you are connecting to a remote server, enter that 
machine’s information. 

i. Enter the server Name (or localhost if you are connecting locally); this is just a 
name to identify the server you’re connecting to. 

ii. Enter the server IP Address or DNS name (or localhost if you are connecting 
locally). 

iii. Enter the Port. Use 20002 (the default) unless the MassTransit server has been 
configured to use a different port.  
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d. Select OK to continue. 
e. After selecting OK you return to the “MassTransit Server List” window and see the server 

you just created. 
4. To connect, highlight the server entry and select Connect. 

 
NOTE: You will be able to connect to the server only when the Engine is running, otherwise a 
dialog will appear stating that a connection cannot be made to the server. 
 

5. The “MassTransit” window appears with a toolbar of the following buttons: Contacts, Status, 
Files, Log, and Setup. Click any button to go to the corresponding window. 

 

Shutting Down the MassTransit Administrator 
To disconnect from the server only, go to the File menu and select Disconnect From Server. To exit the 
MassTransit Administrator, go the File menu and select Exit. 
 
 

Shutting Down the MassTransit Engine 
To shut down the MassTransit Engine, open the Services Control Panel, select the MassTransit service, 
and select the Stop Service button. 
 

Verifying Connectivity 
To ensure that MassTransit can properly connect following the upgrade, attempt outgoing calls to server 
entries and verify that you can receive incoming calls. 
 

Verifying the Web Configuration for Standard and Premier Servers 
For information about upgrading your MTweb configuration follow the upgrading section in the 
MassTransit 6.1 Web Configuration document located on the MassTransit Latest Releases web page: 
http://support.grouplogic.com/mtlatest. 
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Configuring Remote Administration When MassTransit Is Already 
Installed 
In MassTransit the file transfer engine runs as a service and can be accessed for viewing and 
administration by a separate application, the MassTransit Administrator. MassTransit Premier and 
Standard allow local and remote Administrators to connect. Remote administration must be enabled for 
both MySQL and the MassTransit Engine. 
  
The easiest way to configure remote administration for MySQL is to check the checkbox when you install 
MassTransit 6.1. If you already have MassTransit installed and want to enable Remote Administration, 
use the following instructions. Both MassTransit and MySQL will need to be configured before remote 
connections will be accepted. 
 
If remote administration was already configured in MassTransit 5.1 or 6.0, you should not need to make 
any changes to enable remote administration in MassTransit 6.1. 
 

Configuring Remote Administration in MassTransit 
 

1. Via the MassTransit Administrator connect to the local server. 
2. Select the Setup button on the toolbar. 
3. Select the Special tab. 

 
4. Click the Set Remote Administrator Password… button. 
5. The Enter Password dialog appears; enter your password. This password will have to be entered 

by a Remote Administrator when it attempts to connect to your server. 
6. Select the OK button and now any Remote Administrators with the password can connect to your 

server. 
 
 

Configuring Remote Administration in MySQL 
NOTE: This is unnecessary if you selected the Enable Remote login for this account checkbox during 
installation. 
 

1. Launch the MySQL Administrator. 
2. Select the User Administration page. 
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a. Under User Accounts select the “masstransit” account. This account may have a different 
name depending on the username you entered on the “MySQL Settings” dialog during 
the installation of MassTransit. 

 
b. While focus is on “masstransit”, right click and select “Add host from which the user can 

connect”. 
c. The “Add Host” dialog appears; enter the name of the new host, and select OK to 

continue. Using “%” will allow any machine to connect to the database. For security 
purposes, it is better to specify a specific host IP if only a limited number of hosts will 
need to perform remote administration. 

 
d. The new host populates below the masstransit account. 
e. The password on the General tab auto-populates the MySQLpassword used when you 

installed MassTransit. Remote administrators will not need to know this password to 
connect. 
 
NOTE: Do NOT select the Apply Changes button until this host is completely 
configured. 
 

3. Verify the host you just created in the Users Accounts section is highlighted and select the 
Schema Privileges Tab. 

a. In the Schemas section, highlight mtdatabase. 
b. Go to the Available Privileges Section and highlight all of the items listed. 
c. Click the < button so all of the Available Privileges become Assigned Privileges. 



  MassTransit Upgrade Guide – Windows 

 Page 19 

 
NOTE: Do NOT select the Apply Changes button until this host is completely 
configured. 
 

4. Go to the Resources tab. 
a. Configure the values in the Limiting user resources section. The default is “0”; “Unlimited” 

is the default when the MassTransit installer creates this account. 
b. Select the Apply Changes button. 

 
NOTE: When you select the Apply Changes button, it looks like the host you just 
created has disappeared. It has not disappeared; it is just no longer visible from the 
MySQL Administrator. 

 
Now that you have configured both MySQL and MassTransit, Remote Administration is enabled. 
 

Troubleshooting 
Problem: A dialog appears stating, “An error occurred with MassTransit: Remote Administration is 
disabled because the required password has not been configured.” 
Solution: Remote Administration is not enabled in MassTransit; follow Steps 1-6 to configure it. 
 
Problem: A dialog appears stating, “An error occurred with MassTransit: Failed to connect to server due 
to problems initializing – most likely a database issue.” 
Solution:  Remote Administration is not enabled in MySQL; follow Steps 1-4 to configure it.  
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Appendix A: Upgrading from MySQL 4 to MySQL 5 
MassTransit 6.1 requires the use of MySQL version 5.0.78, which allows for faster performance, better 
management, enhanced data integrity, improved security and additional replication services. If your 
current installation of MySQL is version 4, you must upgrade to MySQL 5.0.78 prior to installing 
MassTransit 6.1. The MassTransit 6.1 engine will not run with MySQL 4.  
 

What you will need… 
To complete the MySQL 5 upgrade, you will need:  

3. A mysql-classic-5.0.78-win32.zip file. This file is available on the MassTransit releases web page: 
http://support.grouplogic.com/?page_id=70. 

4. Administrative login permissions for the machine you want to upgrade.  
  

This upgrade procedure assumes that you do not have any other versions of MySQL 5 installed and that 
MassTransit is installed. 

 

MySQL Database Backup 
First you must back up existing MySQL version 4 data. You should have already done in this in the 
previous section: MySQL Database Backup. 
 

Removing the MySQL 4.1 Service 
 

1. Stop the MySQL Service from the Services console inside Administrative Tools. If stopping the 
service fails for some reason, you may also use the following command on 32-bit machines 
(where PASSWORD is the root password for your MySQL 4 server): 

"C: \ Program Files \ MySQL\ MySQL Server 4.1 \ bin \ mysqladminÓ - uroot Ð
pPASSWORD shutdown  
On 64-bit machines, use the following command: 

"C: \ Program Files (x86) \ MySQL\ MySQL Server 4.1 \ bin \ mysqladminÓ -
uroot ÐpPASSWORD shutdown 

 
NOTE: This is imperative, as the upgrade can be compromised if the service has not properly 
shut down. 
 

2. Remove the MySQL Service by executing the following commands at a command prompt: 
  ÒC: \ Program Files \ MySQL\ MySQL Server 4.1 \ bin \ mysqld - nt Ó -- remove  
  ÒC: \ Program Files \ MySQL\ MySQL Server 4.1 \ bin \ mysqld Ó -- remove  

 
NOTE: On 64-bit machines, you should enter the following commands at a command prompt: 

  ÒC: \ Program Files  (x86) \ MySQL\ MySQL Server 4.1 \ bin \ mysqld - nt Ó --
remove  

  ÒC: \ Program Files  (x86) \ MySQL\ MySQL Server 4.1 \ bin \ mysqld Ó -- remove  
 
NOTE: Depending on your existing MySQL configuration, one of these commands may fail with a 
“Command Not Found” error. This is acceptable behavior as long as one of the two commands 
successfully completes and the MySQL service is successfully removed (see Step 5). 

5. Confirm that the MySQL Service has been removed from your Services console. If you have left 
the Services window open while executing these steps, please refresh the window to ensure it is 
up-to-date. 

6. Restart the operating system. 
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Install MySQL 5.0 
1. Unzip the MySQL installation files, mysql-classic-5.0.78-win32.zip, located in your download 

package. A directory opens containing the required installer, Setup.exe.  
2. To install the MySQL engine, double click Setup.exe. 
3. An introduction window appears. Select the Next button to proceed. 
4. The “License Agreement” window appears. The Next button is enabled after you select I accept 

the terms in the license agreement. Read the license and select Next to continue or select 
Cancel to cancel the installation. 

5. The “Setup Type” window appears. Select the Typical setup type and then select the Next 
button. 

6. The “Ready to Install the Program” window appears next. Once you have verified that all of the 
settings are accurate, select the Install button. 

7. While the installation completes, the “Installing MySQL Server 5.0” window appears.  
8. Two “MySQL Enterprise Subscription” windows appear next.  On both windows you may select 

More for more information or Next to continue. 
9. The “Wizard Completed” window appears next. Check the Configure the MySQL Server now 

check box to configure your server. Select the Finish button to proceed. 
10. The “MySQL Server Instance Configuration Wizard” then launches; select Next to continue. 
11. The next window asks you to select a configuration type. Select the Standard Configuration and 

then select Next to continue. 
12. The next window asks you to set the Windows options: 

a. Check the checkbox for Install As Windows Service. 
b. Select MySQL for the Service Name. 
c. Check the checkbox for Launch the MySQL Server automatically. 
d. Check the checkbox for Include Bin Directory in Windows PATH. 
e. Select Next. 

13. The next window asks you to set the Security options: 
a. Select the Modify Security Settings checkbox to set a password for your root account. 

You should use the same password as you used for the root user on MySQL 4.1. 
i. Enter the root password. 
ii. Retype the password for verification. 
iii. Select the Enable root access from remote machines checkbox if you would 

like to give remote machines root access to MySQL. This is not recommended. 
b. Uncheck the Create An Anonymous Account checkbox. 
c. Select Next to continue. 

14. The “Ready to execute…” window appears next.  Select the Execute button to start the 
configuration. 

15. Once the configuration is complete select the Finish button. 
16. Go to the folder where you installed MySQL (the default location for 32-bit machines is 

C:\Program Files\MySQL Server 5.0 and C:\Program Files (x86)\MySQL Server 5.0 for 64-bit 
machines). Open the my.ini file in a text editor. 

17. Add the following line to the end of the file: 
temp - pool=0  

18. Save and close my.ini. 
19. In the services control panel, restart the MySQL service. 

 
The MySQL Installer will automatically install the service and attempt to start the MySQL Engine once 
complete. In the event the service does not start, check the MACHINENAME.ERR file in the C:\Program 
Files\MySQL\MySQL Server 5.0\data (C:\Program Files (x86)\MySQL\MySQL Server 5.0\data for 64-bit 
machines) directory for hints as to the exact reason. See the Troubleshooting section of this document for 
more detail if you encounter problems. 
 

Install Auxiliary Tools 
Install the MySQL Administrator and Query Browser using the mysql-gui-tools-com-5.0-r12-
win32.msi installer package located in your download package. 
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Migrate 4.1 Data to 5.0 
MySQL 5.0 is now installed. Your existing MassTransit data must be restored. To restore the MySQL 4.1 
data, complete the following steps: 
 

1. Stop the MySQL Service from the Services console inside Administrative Tools. 
2. Using your MySQL 4.1 backup created in Step 2 of the MySQL Database Backup, copy the 4.1 

backup data folder into C:\Program Files\MySQL\MySQL Server 5.0 (C:\Program Files 
(x86)\MySQL\MySQL Server 5.0 for 64-bit machines). You can replace the files that already exist 
in that location. 

3. Start the MySQL Service from the Services console inside Administrative Tools 
4. Now it is necessary to make your 4.1 databases compatible with MySQL 5.0. To do this: 

a. Open a command prompt. 
b. Execute the following commands on 32-bit machine: 

cd ÒC: \ Program Files \ MySQL\ MySQL Server 5.0 \ binÓ  
mysqlcheck - gA - autorepair - uroot ÐpPASSWORD 

 
On 64-bit machines, you should execute the following commands: 

cd ÒC: \ Program Files  (x86) \ MySQL\ MySQL Server 5.0 \ binÓ  
mysqlcheck - gA - autorepai r - uroot ÐpPASSWORD 

 
NOTE: Replace PASSWORD with your configured MySQL root password when executing the 
mysqlcheck command. 
 

Security Configurations for MySQL  
It is critical that the directory where the MySQL database files are stored (c:\Program Files\MySQL Server 
5.0\data by default on 32-bit machines and C:\Program Files (x86)\MySQL\MySQL Server 5.0\data by 
default on 64-bit machines) and the Windows temp directory (c:\tmp) be excluded from virus scan and 
server backups. Both virus scan tools and backup tools can lock key files in these folders and interrupt 
operation of the MySQL server, and by extension, MassTransit.  
 
To back up the MySQL databases, it is recommended that you use the MySQL Administrator or other 
standard tools to automatically save the backup files to a directory or volume that can then be processed 
by your backup or archiving solution. 
 
By default, MySQL uses TCP/IP port 3306 to accept client communications. It is recommended to restrict 
traffic on this port by setting appropriate firewall rules.  Normally, the only remote computers that should 
be allowed to access MySQL on the MassTransit server are those running the MassTransit Administrator 
(or those running the MassTransit Engine or MTWeb in the rare configurations where MySQL is not 
running on the same server as MassTransit). 
 
You should configure MySQL with a strong root password of 8 or more characters with a variety of letters, 
numbers, and symbols. To change your MySQL root password: 

4. Open a command prompt. 
5. Enter the following command, where PASSWORD is your current root password:  

ÒC:\ Program Files \ MySQL\ MySQL Server 5.0 \ bin \ mysql.exeÓ Ðuroot ÐpPASSWORD 
 
NOTE: On 64-bit machines you should enter the following command: 
ÒC:\ Program Files  (x86) \ MySQL\ MySQL Server 5.0 \ bin \ mysql.exeÓ  Ðuroot ÐpPASSWORD 
 

6. Enter the following at the MySQL prompt: 
UPDATE mysql.user SET Password=PASSWORD(Ô MyNewPassÕ) WHERE User=ÕrootÕ;  
FLUSH PRIVILEGES;  
Quit;  

 Enter your desired root password in place of MyNewPass in the first command. 
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Your MySQL root password has now been changed.  You may close the command prompt.  
 

MassTransit Running on a Remote Server 
If MassTransit is running on a remote server, separate from where MySQL is installed, you will need to 
execute the following command on the MySQL command prompt before installing MassTransit: 
 

GRANT ALL PRIVILEGES ON *.* TO 'root'@'<REMOTE IP ADDRESS>' identified by 
'<PASSWORD>' WITH GRANT OPTION 

 
In the above statement, replace <REMOTE IP ADDRESS> with the MassTransit Server IP Address and 
replace '<PASSWORD>' with the root MySQL password. 
 

MySQL Upgrade Complete 
The MySQL 5.0 upgrade is now complete. You may now restart the MassTransit Engine. Your 
MassTransit installation is now running against MySQL 5.0.78. You can now proceed with Windows 
Upgrade to MassTransit 6.1 section of this document. 
 
If you allow remote administration of MassTransit and do not click the checkbox for Remote 
Administration as part of the MassTransit 6.1 installation (Step 11), then you will need to follow the 
instruction on how to configure remote administration for MassTransit and MySQL. 
 

Troubleshooting 
 
Problem: MySQL Error 1067 occurs when attempting to start the service. 
Solution: If you encounter a MySQL Error 1067 when attempting to start the service, check the data 
directory in your MySQL 5.0 folder. The file machinename.err (where machinename is your server name) 
will reveal the most common problems. This link explains the issue and a possible resolution: 
http://forums.mysql.com/read.php?11,11388,11456 - msg-11456. 
 
Problem: MySQL will not start, and the machine was not restarted after uninstalling MySQL 4. 
Solution: Installing MySQL 5 immediately after uninstalling MySQL 4 without restarting Windows can 
cause the Server Instance Configuration to fail. To resolve this issue, use the following steps:  

5. Uninstall MySQL 5 Server using Add/Remove Programs in Control Panel.  
6. Delete the MySQL 5 Server folder. This is usually located at C:\Program Files\MySQL 

(C:\Program Files (x86)\MySQL on 64-bit machines). Verify that there are still existing backups 
for the original MySQL 4 database.  

7. Open Registry Editor by clicking Start, then Run…, then typing regedit in the Run window.  
8. Navigate to HKEY_LOCAL_MACHINE/SOFTWARE/MySQL AB and delete the MySQL Server 

5.0 folder.  
9. Restart Windows. Reinstall MySQL Server 5 and proceed with the installation steps from earlier 

in this document. The Server Instance Configuration should now execute successfully. 
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Other MassTransit 6.1 Resources 
Go to http://www.grouplogic.com/files/mt/61/OtherMassTransit61Resources.html for additional articles to 
help you set up, configure, and use MassTransit 6.1 and its new features. The Group Logic Knowledge 
Base contains many articles that provide detailed information on MassTransit 6.1 and its features and 
components. 
 
 

Group Logic MassTransit Technical Support 
Please contact Group Logic Technical Support if you need assistance with upgrading MassTransit. Email 
support@grouplogic.com or call 703-527-7979. For a complete listing of the latest official release versions 
and documentation, go to http://www.grouplogic.com/files/glidownload/mtreleases.cfm. 
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